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Introduction

Do not track
Here is how to set Do Not Track from the menu: Edit > Preferences >
Privacy > Tracking . However, Do Not Track can also be set from
the about:config URI. As a matter of fact, about:config might be consid-
ered the preferred route, as more configuration variables need to be set to en-
sure privacy. (See below.)

• Mozilla Firefox
• Pale Moon
• Netscape legacy
• adheres to the FLOSS philosophy
• precursors of new web technology RSS, javascript, add-ons, chrome,

automatic updates, tabs
• copied by Microsoft and Google
• standards compliant acid test
• The add-ons are what makes this browser so great.
• plethora
• A lot of changes were introduced to the user interface since Firefox

versions 29 & 34; not all for the better. Classic Theme Restorer
• alternative to status bar in Pale Moon
• All extensions specific to Pale Moon
• Firefox add-ons with compatibility issues on Pale Moon
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Figure 1: Do Not Track

about:config
Entering about:config in the address bar will bring up an interface for view-
ing and setting a wide variety of configuration variables, many of which are
not otherwise accessible through the GUI. Take the vow of being careful and
enter below key values in the search field. Double click to change boolean val-
ues.

Table 1: about:config

key new value FF PM

browser.enable_automatic_image_resizing false ✓ ✓
browser.search.showOneOffButtons false ✓ ✗

browser.sessionstore.interval 1800000 ✓ ✓
canvas.poisondata true ✗ ✓
network.standard-url.escape-utf8 false ✓ ✓
privacy.donottrackheader.enabled true ✓ ✓
privacy.trackingprotection.enabled true ✓
security.dialog_enable_delay 0 ✓ ✓
social.* false or '' ✓ ✓
view_source.editor.external true ✓ ✓
view_source.editor.path gvim ✓ ✓

Here are some more cool about:config tips.

• The browser.sessionstore.interval setting in milliseconds is perhaps
the most important here, because Firefox is eating your SSD .

• Pale Moon includes an option to make canvas fingerprinting much more
difficult. By setting the about:config preference canvas.poisondata

to true , any data read back from canvas surfaces will be “poisoned” with
humanly imperceptible data changes. By default this option is switched
off, because of its large performance impact on routines reading this
data.
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Security

Table 2: Security

icon add-on FF PM use

Belgium
eID ✓ ✓

This Firefox add-on allows use of the Belgian electronic
identity card (BeID) for authentication and signing
purposes. Additionally requires eID middleware and
a card reader driver (e.g. ACR38). Finally, you will also
need to manually edit the trust settings of the Belgian
Root Certificates in Firefox. Version 1.0.23 works correctly
with Pale Moon.

Certificate
Patrol ✓ ✓ Reveals when a HTTPS certificate has been updated,

allowing one to check the legitimacy of this change.

Flashblock ✓ ✓

Adobe Flash’s security record has caused several security
experts to recommend to either not install Flash or to
block it. Also Steve Jobs heavily criticised the security of
Flash Player, noting that “Symantec recently highlighted
Flash for having one of the worst security records in 2009.”

HTTPS
Everywhere ✓ ✓

Encrypt the Web! Let Firefox automatically use HTTPS
security on many sites. Certificates can optionally be
checked by the EFF SSL Observatory.

Parental
Controls ✓

MetaCert’s dynamic realtime, cloud-based content
filtering system which adds many thousands of new pages
every hour. MetaCert blocks 700+ million pages of
pornography. That’s more than Norton, McAfee and
OpenDNS combined!

Privacy
Without taking special precautions, one happens to be far less anonymous on
the internet than presumed.

• Pay more because you are a Mac user?
• Fully booked because you visit sites oriented towards afro-americans?
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Table 3: Privacy

icon add-on FF PM use

Adblock
Latitude ✗ ✓ This is a direct fork of Adblock Plus made specifically for

the Pale Moon browser.

µBlock ✓ ✗

µBlock is capable of blocking out almost all ads; including
the ads on this site! It is reputedly more efficient on CPU
and memory than Adblock Plus. Even more importantly, it
is not disloyal to its users, unlike Adblock Plus which has
repeatedly been reported to cheat on its users!

Crush
Those

Cookies
✗ ✓

Get rid of a site’s cookies including its Adobe Flash (Local
Shared Objects) from the moment the pertaining tab is
closed. This happens to be the closest one can get to
cookieless browsing without tedious micromanaging or
breaking every other site. ATTENTION: Be sure to clear
out the whitelist when you start out with this extension.
Add-ons → Extensions → Self-Destructing Cookies →
Preferences → Edit Whitelist → Remove All Sites

Self-
Destructing

Cookies
✓ ✗

Get rid of a site’s cookies including its Adobe Flash (Local
Shared Objects) from the moment the pertaining tab is
closed. This happens to be the closest one can get to
cookieless browsing without tedious micromanaging or
breaking every other site. ATTENTION: Be sure to clear
out the whitelist when you start out with this extension.
Add-ons → Extensions → Self-Destructing Cookies →
Preferences → Edit Whitelist → Remove All Sites

Flashblock ✓ ✓ Selectively allowing Flash may prevent Adobe Flash
cookies from being set during a browsing session.

Privacy
Badger ✓ ✗

A browser add-on of the Electronic Frontier Foundation
(EFF) which stops advertisers and other third-party
trackers from secretly tracking where you go and what
pages you look at on the web. If an advertiser seems to be
tracking you across multiple websites without your
permission, Privacy Badger automatically blocks that
advertiser from loading any more content in your browser.
To the advertiser, it is as if you suddenly disappeared.

anonymoX ✓ ✗

Restore your anonymity on the web and gain access to
blocked or censored websites by tunnelling your IP-traffic
through one of the many anonymoX proxy servers. As of
recently, anonymoX started introducing ad popups on
certain pages. So, use with caution and only when
absolutely necesary!

Above-listed countermeasures are only partially effective. Every browser will
share information about its configuration with the sites it visits. This implies
that a browser is traceable to the point of its uniqueness. The Electronic Fron-
tier Foundation (EFF) offers a free service to test the uniqueness of your
browser configuration. For most of us, the results are sobering. If all you want
is to be less traceable, use a “Private Browsing Window” in Firefox. However,
if you care about privacy, assume that any system is compromised by default.
To attain the highest amount of anonymity on the web currently available, use
Tor from a Linux-based OS that is running from read-only media (e.g. a DVD)
or a virtual machine (VM) environment that is known to be clean. The Tails
GNU/Linux distribution will cater for these specific privacy needs. Also, use
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an internet access point that you usually do not use since all governments are
tapping into ISP access records.

Power management

Table 4: Power management

icon add-on FF PM use

Flashblock ✓ ✓ Steve Jobs was right; Don’t let Adobe Flash eat your battery!

User interface

Table 5: User interface

icon add-on FF PM use

Classic Theme
Restorer ✓ ✗

Restores the user interface to the pre version 29 look
with add-on bar.

Dark
Backgrounds

Switcher
✓ ✗

Allows for night-time reading whilst preventing eye
strain, melatonin deficiency and sleep disorders.
At the flick of a button, this add-on will switch
the background black and set the text colour to yellow
or white.

GlobalFindBar ✓ ✗
Reverts findbar to pre version 25 behaviour; i.e. find
terms are global over all tabs. Dedoimedo also
explained this in more saucy words.

My CopyFixer ✓ ✓
Use [Ctrl]+[C] when nothing is selected to copy
the page title and URL in various formats. Requires
Classic Theme Restorer.

It’s All Text! ✓ (✓)
This extension allows one to use his/her favourite text
editor —like Vim for instance— to edit large text blocks
in the browser. Version 1.9.2 works with Pale Moon.

Speed Dial ✓ ✓ Organise favourite websites in groups of quick dial
buttons with live preview images.

Tab Mix Plus ✓ ✓

Enhance Firefox’s tab browsing capabilities. This add-
on includes such features as duplicating tabs,
controlling tab focus, tab clicking options, undo closed
tabs and windows, plus much more. It also includes
a full-featured session manager with crash recovery
that can save and restore combination of opened tabs
and windows. Version 4.1.9pre.150815a1 works with
Pale Moon.

VimFx ✓ (✓)

Once you get used to modal text editing with Vim,
your fingers will yearn for an add-on like VimFx! This
extension adds Vim-style keyboard shortcuts for
browsing and navigation, effectively eliminating
the need for a computer mouse. Version 0.5.3.1-signed
works with Pale Moon. However, make sure to disable
updates for this specific add-on, by selecting this from
about:addons → VimFX → More.

xclear ✓ ✓ Clear the contents of search fields and the navigation
bar at the click of a button.
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Downloading

Table 6: Downloading

icon add-on FF PM use

MozArchiver ✗ ✓

MIME HyperText (MHT) is Internet Explorer’s
single file web page archiving format. Whereas
the Mozilla Archive Format (MAFF), through its
use of ZIP, results in much more compact archive
files for web pages containing video or audio.
MozArchiver saves and opens both file formats.

UnMHT ✓ (✓)

Save complete web pages, including text and
graphics, into a single MHT file. Allows for
automatic filename string replacements through its
extensive preference settings. Version 7.3.0.5.1-
signed works with Pale Moon, but currently only
for saving.

Video
DownloadHelper ✓ ✓

Download series of video and image links all at
once. Version 4.9.24.1-signed works with Pale
Moon.

Web Developer ✓ ✓ Adds various web developer tools to the browser.

Real-time information
Most of below extensions are designed to show additional real-time informa-
tion in the add-on bar at the bottom of the browser window. However, since
Firefox version 29 the status bar is no longer available by default. Use the Clas-
sic Theme Restorer extension (see previous section) to regain the status bar.

Table 7: Real-time information

icon add-on FF PM use

FoxClocks ✓
use

Pale Moon
version

Shows times around the world in the status bar.
Daylight saving time is automatically dealt with.
Requires Classic Theme Restorer.

Sun Cult ✓ Worldwide Sunrise, Sunset, Twilight, Moonrise and
Moonset…

Weather
Watcher

Live
✓

Get real-time weather conditions, hourly & daily
forecasts, and severe alerts from WeatherBug and
NWS weather stations.

What’s
the Tide? ✓ ✓ Show up-to-date international tidal data in the status

bar, from whatsthetide.com.
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Maps

Table 8: Maps

icon
add-
on

FF PM use

Quick
Maps ✓

Get a Google Maps™ tooltip box attached to any address on any
website or highlight text + use right-click menu to show it on
a map immediately!

Spell Checkers
Spell checkers for use in form fields are installed automatically with (X)Ubun-
tu on a system wide level. Firefox —and for that matter Pale Moon— will
not remember the default spell checking language due to a persistant software
bug.

This can be remedied by installing one —and only one— spell check dictionary
add‑on. This will then create the missing Dictionaries tab in the Add‑on
view. More importantly, this single dictionary add‑on will impose the default
spell checking language upon Firefox and Pale Moon. Meanwhile, any other
system wide languages remain available.

Table 9: Spell checker

icon add-on FF PM use

British
English

Dictionary
✓ ✓ British Dictionary version 2 for Firefox, Thunderbird and

SeaMonkey, forked by Marco A. G. Pinto.

Dictionaries

Table 10: Dictionaries

icon add-on FF PM use

Oxford
Dictionaries ✓ ✓

Search Oxford Dictionaries Online for World English word
definitions, pronunciation, example sentences and
etymology. No subscription required.

S3 Google
Translator ✓ ✓

Add the power of Google Translate’s automatic
translations to your browser! Supports the translation of
selected text, an entered phrase or a whole webpage
between any of 80+ languages.
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https://addons.mozilla.org/en-US/firefox/addon/oxford-dictionaries/
https://addons.mozilla.org/en-US/firefox/addon/oxford-dictionaries/
https://addons.mozilla.org/en-US/firefox/addon/s3google-translator/
https://addons.mozilla.org/en-US/firefox/addon/s3google-translator/
https://addons.mozilla.org/en-US/firefox/addon/s3google-translator/
https://addons.mozilla.org/en-US/firefox/addon/s3google-translator/


Encyclopædia

Table 11: Encyclopædia

icon add-on FF PM use

Wikipedia
(SSL) ✓ ✓ Encrypt data-exchange with the English language

Wikipedia using SSL, with these limitations.

Wikipedia
DE SSL ✓ ✓ Encrypt data exchange with the German language

Wikipedia using SSL, with these limitations.

Wikipedia
(fr) ✓ ✓ Non-encrypted French language Wikipedia

Wikipedia
(es) ✓ ✓ Non-encrypted Spanish language Wikipedia

Wikipedia
(nl) ✓ ✓ Non-encrypted Dutch language Wikipedia

Search engines

Table 12: Search engines

icon add-on FF PM use

Firefox
Add-ons ✓ ✓

Perhaps the most hidden search engine of them all; Once on
the Firefox Add-on web page, click on the down arrow in
the browser’s search field and select “Add Firefox Add-on”.
Now you can use this search engine to look for a specific
Firefox add-on.

Ixquick
HTTPS
Privacy
Search
Engine

✓ ✓

Ixquick.nl is the Dutch English-language counterpart of
Startpage.com, “the world’s most private search engine” — if
we may believe this. Anyhow, being located in
the Netherlands, this browser is subject to European
regulations which tend to protect privacy much more so
than US legislation.

Search
by Image

for
Google

✓ ✓ Right click on an image to quickly find higher resolution
versions via Google Reverse Image search.

QRZ.com
search
plugin

✓ ✓ Swiftly look up ham operator details on QRZ.com, the most
popular amateur (ham) radio call sign database.

Web development

Table 13: Web development

icon add-on FF PM use

Auto Reload ✓ ✓ Reload page automatically when selected local files
are changed.
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https://addons.mozilla.org/en-US/firefox/addon/wikipedia-ssl-243981/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-ssl-243981/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-ssl-243981/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-ssl-243981/
http://en.wikipedia.org/wiki/Secure_Sockets_Layer
http://en.wikipedia.org/wiki/Https#Limitations
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-de-ssl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-de-ssl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-de-ssl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-de-ssl/
http://en.wikipedia.org/wiki/Secure_Sockets_Layer
http://en.wikipedia.org/wiki/Https#Limitations
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-fr/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-fr/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-fr/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-fr/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-es/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-es/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-es/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-es/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-nl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-nl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-nl/
https://addons.mozilla.org/en-US/firefox/addon/wikipedia-nl/
https://addons.mozilla.org/en-US/firefox/
https://addons.mozilla.org/en-US/firefox/
https://addons.mozilla.org/en-US/firefox/
https://addons.mozilla.org/en-US/firefox/
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/uk/download-ixquick-plugin.html
https://ixquick.nl/
https://startpage.com/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/googlesearch-by-image/
https://addons.mozilla.org/en-US/firefox/addon/qrzcom-search-plugin/
https://addons.mozilla.org/en-US/firefox/addon/qrzcom-search-plugin/
https://addons.mozilla.org/en-US/firefox/addon/qrzcom-search-plugin/
https://addons.mozilla.org/en-US/firefox/addon/qrzcom-search-plugin/
https://addons.mozilla.org/en-US/firefox/addon/qrzcom-search-plugin/
http://www.qrz.com/
https://addons.mozilla.org/en-US/firefox/addon/auto-reload/
https://addons.mozilla.org/en-US/firefox/addon/auto-reload/
https://addons.mozilla.org/en-US/firefox/addon/auto-reload/


icon add-on FF PM use

My CopyFixer ✓ ✓
Use [Ctrl]+[C] when nothing is selected to copy
the page title and URL in various formats. Requires
Classic Theme Restorer.

Developer Tools ✗ ✓ The Pale Moon (codename Tycho) Web Developer
Tools

DOM Inspector ✓ ✓ Inspect and edit the live DOM of any web document
or XUL application.

Firebug ✓ ✗
Debug CSS, HTML and JavaScript live in any web
page.

Type-o-matic
Typography ✓ ✗

This add-on extends the before-mentioned Firebug
add-on with tools for untangling web typography.
On any page, find out which fonts are used and how.

View Source
Chart ✓ ✓ Analyze page source in a remarkably efficient way.

Webcompat.com
Reporter ✓ ✗

Easily report web browser bugs and web site
compatibility issues at webcompat.com.

Web Developer ✓ ✓ Adds various web developer tools to the browser.

This work is licensed under a Creative Commons
Attribution‑NonCommercial‑ShareAlike 4.0 International License.

Other licensing available on request.

Unattended CSS typesetting with .

This work is published at https://hamwaves.com/palemoon/en/.

Last update: Monday, March 1, 2021.
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https://addons.mozilla.org/en-US/firefox/addon/my-copyfixer/
https://addons.mozilla.org/en-US/firefox/addon/my-copyfixer/
https://addons.mozilla.org/en-US/firefox/addon/my-copyfixer/
https://addons.mozilla.org/en-US/firefox/addon/classicthemerestorer/
https://addons.palemoon.org/extensions/devtools/
https://addons.palemoon.org/extensions/devtools/
https://addons.palemoon.org/extensions/devtools/
https://addons.mozilla.org/en-US/firefox/addon/dom-inspector-6622/
https://addons.mozilla.org/en-US/firefox/addon/dom-inspector-6622/
https://addons.mozilla.org/en-US/firefox/addon/dom-inspector-6622/
http://en.wikipedia.org/wiki/Document_Object_Model
http://en.wikipedia.org/wiki/XUL
https://addons.mozilla.org/en-US/firefox/addon/firebug/
https://addons.mozilla.org/en-US/firefox/addon/firebug/
https://addons.mozilla.org/en-US/firefox/addon/firebug/
http://en.wikipedia.org/wiki/Css
http://en.wikipedia.org/wiki/Html
http://en.wikipedia.org/wiki/Javascript
http://type-o-matic.net/
http://type-o-matic.net/
http://type-o-matic.net/
http://type-o-matic.net/
https://addons.mozilla.org/en-US/firefox/addon/firebug/
http://24ways.org/2013/untangling-web-typography/
https://addons.mozilla.org/en-US/firefox/addon/view-source-chart/
https://addons.mozilla.org/en-US/firefox/addon/view-source-chart/
https://addons.mozilla.org/en-US/firefox/addon/view-source-chart/
https://addons.mozilla.org/en-US/firefox/addon/view-source-chart/
https://addons.mozilla.org/en-US/firefox/addon/webcompatcom-reporter/
https://addons.mozilla.org/en-US/firefox/addon/webcompatcom-reporter/
https://addons.mozilla.org/en-US/firefox/addon/webcompatcom-reporter/
https://addons.mozilla.org/en-US/firefox/addon/webcompatcom-reporter/
https://webcompat.com/
https://addons.mozilla.org/en-US/firefox/addon/web-developer/
https://addons.mozilla.org/en-US/firefox/addon/web-developer/
https://addons.mozilla.org/en-US/firefox/addon/web-developer/
https://creativecommons.org/licenses/by-nc-sa/4.0/
https://creativecommons.org/licenses/by-nc-sa/4.0/
https://creativecommons.org/licenses/by-nc-sa/4.0/
https://creativecommons.org/licenses/by-nc-sa/4.0/
https://en.wikipedia.org/wiki/Css
https://www.princexml.com/
https://www.princexml.com/
https://hamwaves.com/palemoon/en/
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